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1. SMaRT Concepts 

1.1 THE SMART USER INTERFACE 

Broadly, there are three steps in using SMaRT: setting up the system, 
making the measurements, and displaying the results.  SMaRT clearly 
relates the system set-up and operation to what you are trying to achieve in 
your experiment and enables you to concentrate purely on the measurement 
results.  An introduction to the SMaRT structure is given below. 

1.1.1 SET-UP ENTRIES 

The logically arranged tool bar and menu structure of SMaRT enable you to 
set up an experiment quickly and easily.  Figure 1-1 shows the general 
arrangement. 

 

   Figure 1-1   The 1296 tool bar and menus. 

Many of the tool icon and menu entries lead you into a clearly presented 
window, or series of them, on which you set up your experiment. 
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Many of the tool icon and menu entries lead you into a clearly presented 
window, or series of them, on which you set up your experiment. 

1.1.2 SMART STRUCTURE 

To simplify the 1296 set-ups, the structure of SMaRT is based on projects 
and experiments.   

1.1.2.1 The Project 
A project comprises a set of files relating to a common aim –for example, 
ascertaining the properties of a particular type of material.  The Project 
Viewer represents the project on the SMaRT display.  This shows all the files 
presently included in the project, in the form of icons.  The types of files used 
are: 

• Experiment file – specifies the hardware to be used for a particular 
experiment. 

• Data file – contains the data obtained by running an experiment. 

• Graph file – specifies a graph configuration and points to the data file 
containing the data to be plotted. 

• Report file – contains a summary of an experiment that has been run. 

A project may embrace several experiments and each one will have its own 
data and report file assigned to it. 

1.1.2.2 The Experiment 
To create an experiment you use the Experiment Editor.  Here you define: 

• The filename of the experiment file, and where to save it, 

• The file to be used for the experiment data, 

• The experiment parameters, such as ac level, frequency and 
temperature 

Having created an experiment, you must save it to make it available.  An 
experiment icon then appears on the Project Viewer.  Any experiment thus 
created can then be run to acquire the materials testing data.  The ways in 
which you can view this data are introduced in Section 1.2. 

A summary of the SMaRT set-up and data acquisition and display procedure 
appears in Section 2.1 of this user guide. 
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1.2 SMART PROCESSING AND DISPLAY FACILITIES 

When you run an experiment the basic voltage and current data are stored 
in memory.  SMaRT is able to retrieve this data, and to process and plot the 
data in near real-time or historically.  A detailed analysis of cell performance 
is thus provided, in graphical or tabular form. 

You set up the graph you wish to plot on the graph set-up window.  The 
procedure for this is given in Section 7. 

1.2.1 SELECTING THE PLOT TYPE 

On the Plot Type tab, you select the type of graph you want.  This can be for 
Impedance plots, Bode or Complex plane.  On the other five tabs you 
proceed from left to right, setting up the trace(s), x-axis, y-axis, etc, as 
explained in the following sections.  When graph configuration is complete, 
click on OK to display the graph. 

1.2.2 SETTING UP THE TRACES 

On the Trace Set-up tab, you assign a data file to each trace to be plotted on 
your graph.  Up to eight traces may be plotted on the same graph. 

For each trace, you follow the same simple set-up procedure: 

1. Select a trace on which to plot the data. 

2. Attach the trace to the relevant y-axis, Y1 or Y2.   (The Y2 axis may be 
enabled, or not, for Impedance plots.) 

3. Select the data file containing the data you wish to plot. 

4. Select the range of data you wish to plot.  (For time related data, for 
example, you can define the period that the plot is to cover.) 

In step 4 of the trace set-up procedure, you have the option of selecting: 

• For historic data: 

• The date and time when the data was obtained, 

• The number of times you wish to plot a repeated experiment, 

• The period of the data to be plotted 
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1.2.3 SETTING UP THE X-AXIS 

The type of units you can plot on the x-axis depends on the selection you 
make under Plot Type.  By default, the x-axis is in units of Frequency for 
Impedance plots.   

You can select alternative units to suit your needs.  These units include 
magnitude, phase and real for impedance plots.  Full lists of the units 
available are shown in Table 1-1. 

1.2.4 SETTING UP THE Y-AXES 

The type of units you can plot on the y-axis depends on the selection you 
make under Plot Type.  The default units for Impedance plots are Y 
=magnitude and Y2 =phase.  You can select alternative units to suit your 
needs.  These units include impedance real and imaginary, or admittance 
magnitude and phase for impedance plots.   

1.2.5 SETTING UP THE VIEW 

On the View window, you set up the general appearance of your graph.   

The Display options apply to all graphs.  With these, you can: 

• Display the grid, or not, 

• With the grid displayed, display the minor divisions, or not, 

• Display the cross-wire cursors, or not, 

• Display the legends (trace labels), or not. 

The Complex plane options are available only with Complex plane selected 
as the Plot Type.  These options allow you to: 

• Use isotropic scaling (equal scaling on x- and y-axes), or not, 

• Invert the y-axis, or not. 
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2. Using SMaRT 
On starting SMaRT, you will see the Welcome to Smart panel:   

 

This gives you three options and the choice you make will depend on 
whether you are a new or experienced user.   

New users should choose Getting Started!  This presents you with the few 
simple steps you will follow to create your first project: 

 

The aim of this is to get you started in running tests.  We recommend that 
you first connect a sample of the material under test, as described in the 
1296 User Guide.  Then use the Getting Started procedure outlined below to 
get to know the facilities offered by the 1296 Unit and SMaRT.   

To create your project, click in turn on each button on the Getting started… 
panel, starting at the top with the Creating your project.  You thus progress 
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through a simple three-step procedure.  Sections 2.1 through 2.3 below 
introduce you to the type of windows you will encounter in setting up a 
project and you are shown how you create and manage projects and 
experiments within SMaRT.  In each section, reference is made to more 
detail in later sections of the User Guide.  

Having set up your initial project, you can start your experiment.  Section 
2.4 shows you how.  On the successful completion of the experiment, you can 
view the data acquired.  Section 7 of the User Guide gives full details. 

The other two options on the initial Welcome to SMaRT panel allow you to 
Create a new project or Open your previous project.  Use these when you 
are familiar with the operation of SMaRT, to enable you to set up your 
project directly.  
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2.1 CREATING YOUR PROJECT 

To start creating your first project, click on this button: 

 

This reveals the Project Settings window1.  Initially, all you do here is give 
your project a name and say where you want the project directory saved.  
Once projects have been created, you will have the option of creating a new 
project or recalling an existing one.  When you click on OK to assign your 
project name, the Project Viewer appears: 

 

Your project will consist of a group of files related to one or more 
experiments with a common aim.  This will be to do impedance tests on a 
particular type of material, for instance.  In creating a project, you open a 
project directory and assemble in this the files that you wish to use in the 
project.  The header icons that appear in the Project Viewer, as shown in the 
example above, indicate the types of files that you will use.  At this time, 
there are no files in the project directory.  Icons representing these files will 
appear as soon as you create them, or, later, add them from other projects.   

Full details of how to create and manage a project appear in Section 4 of the 
User Guide. 

                                                

1 You can access this window directly, by selecting Create a new project on the initial 
Welcome to SMaRT panel. 
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2.2 SPECIFYING THE SYSTEM HARDWARE 

To specify the hardware you are going to use for your experiment, click on 
this button: 

 

This reveals the Hardware settings window: 

 

On this, you specify the type of Interface, FRA and Temperature Controller 
you are going to use and their addresses and options. 

Full details of how to specify the system hardware appear in Section 3 of the 
User Guide. 
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2.3 DESIGNING YOUR TEST SEQUENCE 

To start designing the test sequence for your experiment, click on this 
button: 

 

This reveals the Experiment Editor window: 

 

Here you add a series of tasks, which define the experiment parameters.  
For example, you can enter the frequency and level of the ac source, the dc 
bias, and the measurement parameters.  You can also set up a sweep, of the 
frequency value for example, or you if you wish can set up several nested 
sweeps.  Full details appear in Section 5 of the User Guide. 
 
Included in the experiment set-up, is the sample definition.  Here you enter 
the information that enables the 1296 to compute the relative permittivity of 
the sample to be measured.  The information you enter can be either the cell 
dimensions or the empty cell capacitance. 
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2.4 STARTING AN EXPERIMENT 

As you complete each step of the Getting Started procedure, a green tick 
appears against it and, on completion of the last step, a message prompts 
you to start running the experiment: 

 

Selecting Yes reveals the window entitled, “Please choose an experiment to 
start…” 

 

All you do here is select an experiment from the list and click on the Start 
button.  The experiment is then executed.   

Initially, of course, there will be just the one experiment to choose from, but 
once several experiments have been created, you can choose any one of them 
from the list displayed.  The browse button enables you to search for and run 
experiments other than those listed under your current project. 

Full details of how to run experiments appear in Section 6 of the User 
Guide. 
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2.5 VIEWING THE RESULTS OF YOUR EXPERIMENT 

On completion of your experiment, an icon representing the data file appears 
on the Project Viewer.  Double-click on this icon to reveal the Data File 
Information window: 

 

Here, you can opt to view your data as a graph or in tabular form.  You can 
also repair damaged data files, or convert them to .CSV format for export to 
other applications such as Excel. 

Full details of the ways you can view your data appear in Section 7 of the 
User Guide 
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3. Specifying the System Hardware 
The system hardware includes the Impedance/Dielectric Interface and any 
other equipment that may be required, such as option cards, FRAs and 
temperature controllers.  

3.1 ENTERING THE HARDWARE SET-UPS 

To be able to use an item of hardware you must first assign it to the system 
software.  The procedure is: 

1. Click on the Add/Remove hardware icon in the 
toolbar (or, in the Tools menu, click on Hardware 
settings…).   

This displays the Hardware Settings window: 

 

2. On the three tabs of the Hardware Settings window, select the Interface, 
FRA, and Temperature Controller you intend to use in your project.  For 
each of these you will also need to define the port address and type of 
connection used.  See Sections 3.1.1 through 3.1.3 for the details 

The GPIB settings apply to the interface or Frequency Response 
Analyser.  If in doubt as to whether or not you have entered the correct 
GPIB address, click on Search GPIB.  The message, Searching for 
hardware on the GPIB…  please wait, is then displayed, followed by the 
result of the search.  If necessary, correct the GPIB address.  The serial 
port settings apply to Temperature Control Units.  The Test Hardware 
facility enables you to check the response of an instrument when 
addressed. 

3. Click on OK to register the hardware set-up.  
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3.1.1 SETTING THE DIELECTRIC INTERFACE 

 

Model: 1296, 1294 or none (1260 stand alone mode) 

Card No. Identifies the system controller GPIB card in the PC  

Address: GPIB address of the Dielectric Interface (1 through 8) 

3.1.2 SETTING THE FREQUENCY RESPONSE ANALYSER (FRA) 

 

Model: Solartron 1260, 1250, 1253, or 1255, or Hewlett Packard HP4192 
 (See Appendix E for details.) 

Card No. Identifies the system controller GPIB card in the PC  

Address: GPIB address of the FRA (1 through 8) 

 Note:  The FRA uses two addresses the even one shown in the 
Address box and the address that follows it.  A warning is 
displayed if you attempt to enter the second FRA address for any 
of the other instruments in your system. 
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3.1.3 SETTING THE TEMPERATURE CONTROLLER 

 

Model: ‘None’ –an instrument controlled from outside the system, as 
selected above– ‘Lakeshore 340’, ‘Oxford Instruments ITC503’, or 
‘Eurotherm 2000 Series’. 

 If you choose to adjust the temperature manually, SMaRT 
prompts you to do this whilst the experiment is running.  If no 
temperature control is required then select manual mode –and 
select fixed, with no prompt in experiment set-up. 

 Note: The temperature controllers Lakeshore 340 and Oxford 
Instruments ITC503 are set up, prior to being operated, from 
their respective set-up files.  These files, which are supplied with 
the impedance measurement software, are Lakeshore.set and 
oi_setup.set.  Guidance on modifying the content of these files for 
your particular application is given in Appendix C of this 
manual. 

Address: For Lakeshore 340, Oxford Instruments ITC503, or any other 
temperature control device, you must enter an RS485 address. 

Set-up File: For Lakeshore 340 and Oxford Instruments ITC503, you must 
select a set-up file.  For any other type of temperature control 
device, you must select a set-up file and a DLL file. 
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4. Creating and Managing a Project 

4.1 PROJECT FILES 

A project contains the files of a common category of experiments.  This 
allows you to manage the files related to a particular project, which keeps 
everything nice and tidy.  To identify a project you enter a title in the project 
name box.  You can enter a broader description of the project in the 
“comments” box. 

The file types contained in a project are: 

• Schedule - holds a test sequence: charge, discharge, etc. 

• Experiment file - holds a definition of the hardware to use for an 
experiment and the name of the data file to use. 

• Data file - holds the data generated by an experiment. 

• Graph file - holds the settings of a specific graph and reference to the data 
file holding the data you wish to plot. 

• Report file - holds the text that summarises a specific experiment, i.e. 
general information that you may wish to print and file. 

• Other files. 
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4.2 CREATING A PROJECT 

The basic procedure for creating a project is: 

1. Click on the Create a new project icon in the toolbar (or, 
 in the File menu click on New �Project...).   

The following message is then displayed: 

 

This gives you the option of saving your current project (should you have 
created one prior to starting another).  ‘Yes’ saves the current project – 
‘No’ discards it.  In either case, the Project Settings window appears.  
‘Cancel’ aborts the creation of a new project. 

The Project Settings window appears thus: 

 

2. Enter a name for your project.  This name will appear on the project map.  
If required, enter a brief description of the project under Comment. 

3. By default, the project name is adopted as the filename, but you can 

modify this as you think fit.  To set a filename, click on the relevant  
button.  Beware of using illegal characters in the filename.  The directory 
path shows where the directory is to be stored: this too can be modified, 

by clicking on the other  button. 

4. To save the project, click on OK.  The Project Viewer then appears: 
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Icons representing the various files in the project will appear as these files 
are saved.  Note that there are other project ‘tree’ styles.  See Section 8.3. 
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4.3 MANAGING A PROJECT 

The thing to remember when managing a project is that it is simply a group 
of related files (experiments, schedules, data files, etc). 

The four aspects of project management are: 

Loading: When you load a Project, you are making available the files 
relating to a cell test application.  Only one Project can be 
loaded at a time. 

Adding files: If you wish, you can add new files or other components to 
your current Project.  You can also access and use the files of 
other Projects. 

Backing up: As a precaution against experiment data being lost, it is 
possible to back up the Project component files.  You can 
select daily backups, at a selected hour, or periodic backups, 
at defined periods. 

Saving: Saving a Project retains the grouping of the experiments, 
schedules, etc. of your current project, but it does not back up 
the component files.  Omitting to save, or deleting a project, 
does not lose the component files, only the reference to them. 

The way in which you deal with each of these aspects of project management 
is described in sub-sections 3.3.1 through 3.3.4 below. 

4.3.1 LOADING A PROJECT 

As an option, you can choose to have your previous Project automatically 
loaded when the application starts up.  If you don’t select this option then 
you have the choice either of creating a new project or of opening a 
previously saved project file.  A list of recent projects is accessible from the 
File menu. 

Note that only one Project will run at any one time.  An attempt to load a 
project while another is running presents you with the choice of saving or 
discarding the present Project.  Should you discard a project, you do not lose 
the files it contains −only the project ‘shell’.  If you wish to delete the files as 
well, you must do this separately. 
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4.3.2 ADDING FILES FROM OTHER PROJECTS 

To add files from other projects, click on Add Files to Project… in the File 
menu.  Then Choose a File to Add and Open it. 

Should you have set the message option ‘Suggest file copy when adding 
external files to project?’ (Section 10.4) you will see the following message:  

 

Select Yes to copy the file to your current project or No to access the original 
file.  The first option is useful for creating one file from another, when you 
can leave the original file intact.  You could perhaps use the second option 
where commonly used files are stored centrally and where any changes 
made are with the knowledge and approval of all users. 

In addition, you can ‘drag and drop’ files into your project, using the 
Windows File Explorer.  These files are always referenced in their original 
location, regardless of the above option. 

4.3.3 SAVING A PROJECT 

Saving a Project retains the grouping of the experiments, schedules, etc. of 
your current project.  Declining to save a Project deletes the grouping, but 
the individual components remain available for use in other Projects.  
Similarly, removing a component from the project map does not delete the 
component itself, only the reference to it.  If you wish to delete the 
component itself, you must do this separately, by clicking on Delete: you 
must delete a file, for example, from the relevant project directory. 
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5. Creating an Experiment 

5.1 USING THE EXPERIMENT EDITOR 

To define an experiment you must specify the way in which the 1296 
Dielectric Interface is to drive the sample during the experiment.  You must 
also specify the data file to be used for the experiment results. 

To create an experiment you use the Experiment Editor.  You can access this 

either by clicking on the  icon in the toolbar or by selecting  
New �Experiment in the File menu:   

 

At the top of the Experiment Editor window, you can enter both a comment 
and the filename for the experiment data.  To enter the comment (30 
characters maximum) you simply type it into the text box:   

 

When you save the experiment, the comment will appear against the 
relevant experiment icon on the Project Viewer. 
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To define the filename for the experiment data, click on the  button and 
use the window entitled Choose a data file for this experiment…   

 

When you save this file name, it appears under Data file at the top of the 
Experiment Editor window.  When you run the experiment, a data file icon, 
thus identified, appears under the relevant experiment icon on the Project 
Viewer. 
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5.2 CREATING AN EXPERIMENT 

To create an experiment, you add tasks by using the  button.  This 
button opens the Add New Task window, which contains a set of buttons 
that point to all the tasks you will need to perform: 

 

Each button shown here brings up a window for setting a specific 
experiment task.  Defining the measurement frequency, for example: 

 

In this particular window, you can set a fixed frequency for the 
measurement frequency.  Alternatively, you can set the start and end 
frequencies of a linear or logarithmic frequency sweep.  You also have the 
option of setting a list of randomly defined frequency points. 

Similar windows exist for setting the ac and dc levels and temperature.  For 
the 1294, you can also select the Voltage or Current generator mode.  For dc 
level and temperature, you have the option of prompting for manual control 
at each point in the sweep. 
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As you define each task, an icon representing it appears in the Experiment 
Sequence diagram.  For example: 

 

The order in which tasks are shown represents their order of execution.  In 
the sequence above, task 1 sets the sample temperature to 303°K (30°C), and 
tasks 2 and 3 set the ac and dc levels of the FRA generator output to 500mV 
and 1V respectively.  Task 4 then imposes a settling delay of 60 seconds.  
Following this, tasks 5 and 7 sweep the frequency of the FRA generator 
output from 10kHz through to 1kHz and with Task 6 making a 
measurement at each frequency point.  Task 8 then repeats the swept 
frequency measurements five more times. 

Use  or  to change the order as required. 

Note the two loops in the above sequence.  The outer (green) loop is 
implemented by inserting a loop task.  You can set this to repeat all or part 
of the experiment sequence a defined number of times.  You select the tasks 

to be repeated by moving the loop start icon  to precede the first 

task in the repeat sequence and the loop end icon  to follow the last. 

To edit an existing experiment task, select  to reveal the task set-up 
window.  Reassign the task parameters and OK them, same as during the 
initial setting up. 

To delete an unwanted task from the experiment, select the task icon and 

then . 
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Having set up all the experiment tasks required, and defined the sample, 

select  to save the experiment.  The experiment icon  then 
appears on the Project Viewer: 

 

Note the comment: [Example of an experiment set-up].  This is the one 
entered at the top of the Experiment Editor.   You specify the experiment 
filename, in this example “Set-up 1.exp”, when you save the experiment. 

To edit an existing experiment, double-click on  to reopen the 
Experiment Editor.  You can then edit, add and/or delete tasks, before 
saving the experiment, either as an updated version or as a completely new 
one. 
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5.3 DEFINING THE SAMPLE 

The Sample Definition window enables you to enter the empty cell 
capacitance of the sample, or the dimensions from which this may be 
derived.  The empty cell capacitance enables the 1296 to compute the 
relative permittivity of the sample. 

To enter the sample definition, click on the  button.  This reveals 
the Sample Definition window: 

 

You can define a sample in either of two ways: enter the sample dimensions 
and let the 1296 compute the empty cell capacitance; or enter the 
capacitance value direct.  The first method is suitable for a sample for which 
you know the dimensions, but cannot remove the dielectric.  The second 
method is suitable for samples of an irregular shape: if you do not know the 
empty cell capacitance, but you can remove the dielectric, the 1296 can 
measure the capacitance for you. 
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5.4 SETTING UP A MEASUREMENT 

The 1296 unit offers two methods of making an impedance measurement - 
normal or reference.  With the normal method, a single direct measurement 
is made.  The results that this gives are accurate at low frequencies, but 
errors due to stray impedances can arise at high frequencies. To avoid this 
problem, you can use the reference method.  With this, two measurements 
are made: one of the sample and one of a reference capacitor of comparable 
value.  From the ratio of the two results and the reference capacitance value 
the 1296 computes the true sample value. 

To reject any noise that may be present in the sample signal the 1296 allows 
you to select integration of the Analyser input. 

The measurement method can be set at various points in the experiment 
sequence, to suit the parameters of the sample stimuli –which are the 
parameters set for the generator output.  For example, you can use the 
reference method for high frequency measurements and the normal method 
for low frequency measurements.  These measurement methods are 
discussed in more detail below. 

To set the measurement method, simply add an Impedance Measurement 
Set-up task to the experiment sequence.  With the 1296 selected as the 
hardware interface, the window for this has two tabs, one for selecting the 
analyser integration and the other for selecting the measurement method: 

 

 

The use of these settings is described in Sections 5.4.1 and 5.4.2. 
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Alternatively, with the 1294 selected as the hardware interface, two further 
tabs appear: 

 

 

One of these is for coupling and ranging of the FRA input and the other is 
for generator balancing.  The use of these settings is described in Sections 
5.4.3 and 5.4.4. 

5.4.1 SELECTING THE ANALYSER INTEGRATION (1294/1296) 

Noise that is present in the signal applied to the Analyser can be rejected by 
a process known as signal integration.  This process averages the signal over 
a whole number of cycles, which narrows the measurement bandwidth and 
thus increases the signal to noise ratio.  The more a signal is averaged the 
longer it takes to get a result, so there is a trade-off between the accuracy 
you require and the measurement speed. 

The measurement set-up defaults to a fixed Integration Period, with auto 
integration off.  If you wish to use a fixed integration period, enter the period 
you require, in seconds or cycles, in the Integration Period box.  Select cycles 
or seconds by clicking on the relevant option.  If you know what accuracy you 
want in your results, but you don’t know how much integration is required 
to obtain this then a possible solution is to use Auto Integration: 
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Auto Integration averages the signal until the standard deviation reaches a 
target value.  Details of the standard deviations obtained are given in the 
relevant FRA manual.  To avoid excessive measurement times, you assign a 
Maximum Period, in seconds or cycles. 

When you enter a value in seconds the 1296 or 1294 always selects the most 
appropriate number of whole cycles.  You must specify at least one cycle for 
the Analyser to operate. 

5.4.2 SELECTING THE MEASUREMENT METHOD (1296) 

The measurement set-up defaults to normal measurement.  To select the 
reference method, click on internal or external reference in the reference 
mode menu. 

By adding an Impedance Measurement Set-up task at two different points in 
the measurement sequence, you have the option of using the normal method 
for measurements below a specified frequency and the reference method for 
measurements at frequencies above. This is worth doing when you can 
obtain the same accuracy with either method over the lower part of the 
frequency range.  The normal method makes only one measurement per 
result and this saves time.   

The frequency below which you use the normal measurement mode depends 
on the sample and therefore you must find this frequency by experiment.  
The easiest way to do this is to make two frequency sweeps, one using the 
normal method and the other using the reference method.  Compare the 
results on a graph and note the frequency at which the traces diverge.  
Above this frequency, you should use the reference method.  Below it, you 
can use the normal method.  You should then obtain a consistent accuracy 
throughout the sweep, for this particular sample. 

5.4.2.1 Selecting the Reference Capacitor 
For the internal reference, the 1296 unit automatically selects a capacitance 
that is comparable to that of the sample.  If you wish to use an external 
reference, however, you must connect a suitable capacitor to the 1296 unit 
yourself.  You must also enter the capacitance and conductance values of 
this capacitor, on the Reference tab of the Impedance Measurement Set-up 
window. 

If you use a wide range of frequencies, you may need to use several different 
values for the external reference capacitor to maintain measurement 
accuracy.  To do this you will need to conduct a series of experiments, for 
each experiment using a suitable reference capacitor. 
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5.4.3 ANALYSER INPUT RANGING AND COUPLING (1294) 

The voltage sense range of the measurement inputs is used to measure the 
differential voltage across the sample.  The current sense range is used to 
measure the current through the sample. 

The sample current is converted to a voltage in the 1294.  This voltage is 
then measured by the FRA.  (Channel 2 of the FRA, which is used for this 
purpose, is always in auto-range.) 

It is best to leave the Voltage range and Current range settings on ‘Auto’.  
This ensures that an optimum range is selected automatically, in keeping 
with the signal amplitude.  Automatic range selection aims at selecting the 
least sensitive 1294 range and the most sensitive FRA range possible, thus 
ensuring the widest possible measurement bandwidth and highest accuracy. 

Should you wish to specify the current sense range yourself then you should 
note the following: 

• The current sense ranges are listed as conversion factors: 1V/mA, 
1V/10mA, 1V/100mA, and so on.  This means that 1V represents 1mA, 
or 10mA, or 100mA, and so on, depending on the conversion factor that 
you select. 

• In keeping with the conversion factor selected and the current range 
required for the experiment, you must ensure that the FRA can 
automatically select a suitable range for the voltage representing the 
sample current.  For example, if the maximum current expected in the 
experiment is 30mA then you could select a current sense range setting 
1V/1mA.  The maximum voltage fed to the FRA would then be 30mV, so 
the FRA should auto-range to the 30mV range. 

• Should you wish to obtain a higher voltage to current ratio, then you 
could, in the above example, select a current sense range setting of 
1V/100mA.  This would give 300mV as the maximum FRA input voltage 
and would require the FRA to auto-range to the 300mV range.  The 
more sensitive 1V/100mA range has, however, a lower bandwidth than 
the 1V/mA range. 

Provision is also made for the selection of ac or dc coupling at the FRA input. 
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5.4.4 GENERATOR BALANCING (1294) 

The generator balance facility enables the generator, in voltage drive mode, 
to compensate for external impedances, such as those contributed by the 
sample electrodes and test leads.  These impedances (represented by Z1 and 
Z2 in Figure 5.1) act with Z sample as a potential divider and cause a 
common mode signal to appear at the V INPUT LO terminal.  A leakage 
current can thus be made to flow from the V INPUT LO terminal to ground.  
This current flows through the sample, but, since it does not flow into the 
GEN LO terminal, it is not measured. This leads to errors in current 
measurement. 

The aim of generator balancing is to avoid a common mode signal at the V 
INPUT LO terminal.  For this purpose, anti-phase versions of the drive 
voltage signal are applied at opposite ends of the measurement circuit.  The 
relative amplitudes of the opposing signals are adjusted automatically, such 
that the voltage at the V INPUT LO terminal is minimised. 

 

   Figure 5-1   Generator balance for four-terminal measurement. 

Three balance settings provide for various experiment conditions:  

Off, where balance is not required,  

Fast where balanced measurements are required, but speed has priority,  

Accurate where balanced measurements are required, but precision has 
priority. 

Depending on the rate at which the external impedances are likely to 
change, you can also arrange for balancing to occur at every n

th
 

measurement.  This can be used to advantage where measurement precision 
and speed are both important. 
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6. Running an Experiment 

6.1 STARTING AN EXPERIMENT 

The procedure for starting an experiment is: 

1. Click on the traffic light icon… 

…or on Start Experiment… in the Control menu. 

A window entitled Please choose an experiment to start… appears: 

 

2. On the above window, select an experiment then click on the Start 
button: 

3. Under Tools, Options, Graphics you have the option Show a new graph 
when the experiments starts.  (See Section 10.2, ‘Selecting the General 
Options’.)  If this option is selected, a message appears, before the 
experiment starts, giving you the option of configuring the real-time 
graph of the experiment results: 

 

If you select yes, the graph configuration window appears (see Section 
9.1).  If you select no, the experiment results are plotted on a default 
graph of voltage against time. 
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Following step 3 (or step 2, if the graph option mentioned in step 3 is not 
selected) the experiment starts and its progress is shown on the System 
Status Grid. 

The grid shows, for each channel in the experiment, the quantities 
measured and the estimated measurement time left.  Stop, run and skip 
buttons are also included, for each channel.  This is demonstrated in the 
following example. 

 

6.2 STOPPING AN EXPERIMENT 

To stop all experiments, click on the  button in the CellTest tool bar or 
on Stop in the Control menu.  The stop button is intended for emergency 
stops.   

However, as with all computer-controlled systems, you should not rely on 
this alone.  This is because a communications failure may prevent the stop 
command being actioned.  This applies particularly where injury or damage 
could result from a critical experiment.  In such a case, it may necessary to 
disconnect the ac supply to the unit that is driving the critical experiment. 

Sensible precautions should be taken against the possible hazards of a 
critical experiment –explosion, fire, and corrosive liquids, for example– 
which could occur before the experiment is brought under control.  This 
could take the form of a complete enclosure or a screen, depending on the 
degree of danger.  Fire prevention should also be considered.  All precautions 
should be taken in accordance with local safety regulations regarding 
hazards of this nature. 
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7. Viewing Your Results 

7.1 PREPARING TO VIEW 

Once you have run an experiment, data is available in the designated data 
file(s) and a representative data file icon appears under the Other Files icon 
on the Project Viewer.  Double clicking on the data file icon opens the Data 
File Information window, which contains a summary of the filed data.  Here 
you can select the data you wish to study and how you wish to view it: as 
data, in tabular form, or as a graph.  You can also convert your data before 
viewing it.  

 

The procedure for viewing a graphs and tables is described in Sections 7.2 
and 7.3, whilst file conversion is described in Section 7.4. 
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7.2 VIEWING YOUR RESULTS ON A GRAPH 

For real-time or historic graphs, you configure the presentation in the same 
way.  The only difference between the two is the way in which the data 
appears.  Real-time graphs build up as the experiment proceeds, whereas 
historic graphs represent filed data already acquired and appear as a 
complete plot. 

To access the graph configuration windows, select View 
Graph on the Data File Information window or click on the 
Show a graph icon in the toolbar.  This reveals the six graph 
configuration windows.  Sections 9.1.1 through 9.1.6 below explain the use of 
these.  When graph configuration is complete, click on OK for plotting to 
begin.  Note that you can Save a graph configuration and Load a previously 
saved one. 

7.2.1 SELECTING THE PLOT TYPE 

On the Plot Type window (Figure 7.1), select the type of graph you want.  
This can be for Bode or Complex plane.  From here, you proceed from left to 
right, setting up the trace(s), x-axis, y-axis, etc, as explained in the following 
sections.  When you finish configuring your graph, click on OK to display it. 

 

   Figure 7-1   Graph configuration: plot type. 
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7.2.2 SETTING UP THE TRACES 

On the Trace Set-up window (Figure 7.2), you assign the data you wish to 
plot.  Up to eight traces, selected from various data sources, can appear on 
the same graph.   

 
   Figure 7-2   Graph configuration: trace set-up. 

The procedure for assigning data to a trace is: 

1. Select a trace on which to plot the data.  Under Trace set-up, select a 
Trace No. (e.g. ‘1’) and click to tick Enabled.  To make it easier to 
differentiate between several traces on a graph, each trace has a different 
style, e.g. colour, thickness, etc.  If you wish to define your own styles, you 
can do this in the Style window.  To plot a trace against the Y2 axis, click 
to tick Attach to Y2 axis. 

2. Select the Filename of the file containing the data you wish to plot. 

3. Select the required sweep.  To accommodate nested sweeps, the currently 
selected parameters are presented in four boxes entitled Frequency, AC, 
DC and Temperature.  Simply select the values defining the trace you 
require.  A typical example of nested sweeps could be: at each of three 
temperatures 300°K, 350°K and 400°K, and at each of three ac levels 
1Vrms, 2Vrms and 3Vrms, run the frequency sweep 1kHz through 10kHz.  
Here, you would have 1, 2, and 3 listed under AC and 300, 350 and 400 
listed under Temperature.  Selecting ‘2’ and ‘350’ would select the trace 
for a temperature of 350°K and ac level of 2Vrms. 

4. Repeat steps 1 through 3 for each trace you wish to plot. 
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7.2.3 SETTING UP THE X AXIS 

The type of units you can plot on the x-axis depends on the selection you 
make under Plot Type (see Section 7.1.1).  By default, the x-axis is in units 
of Frequency for Bode plots.  You can select alternative units to suit your 
needs, under Type.  (See Figure 7.3.)  Full lists of the units available appear 
in Section 1. 

To plot the full duration of the data that is available from your selected data 
source, click to tick Auto scale.  Alternatively, to plot part of the data, you 
can define the Min and Max limits of a fixed scale.  Assume, for example, 
that the full frequency range of your data is 0Hz through 1MHz and you 
wish to plot the frequency band 100Hz through 10kHz.  First, deselect Auto 
scale, by clicking with the left mouse button.  Then set Min to ‘100’ and Max 
to ‘10000’.  Note that you can also enter the fixed scale values in exponential 
form, which in the present example would be Min =1e2 and Max =1e4. 

To plot your results in the most meaningful way, you can select Linear or 
Logarithmic scaling. 

 

   Figure 7-3   Graph configuration: x-axis. 
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7.2.4 SETTING UP THE Y AXES 

The data type you can plot on the y-axis depends on the selection you make 
under Plot Type (see Section 7.1.1).  By default, the data types selected for 
Bode plots are Y =magnitude and Y2 =phase.  You can select alternative 
data types to suit your needs, under Type.  These include impedance real 
and imaginary, or admittance magnitude and phase for Bode plots.  Full 
lists of the units available appear in Section 1. 

Beside each Y-axis, you will see the data type label.  By default, the labels 
are the data type and units.  You can enter your own label for each trace 
under Label.  This then replaces the default label. 

To cover the full range of data available on all selected traces, click to tick 
Auto scale.  Alternatively, to plot the amplitudes within a restricted range, 
you can define the Min and Max limits of a fixed scale.  Assume, for example, 
that the amplitude of your data ranges between 1kΩ and 100MΩ, and you 
are interested in amplitudes between 10kΩ and 1MΩ.  First, deselect Auto 
scale, by clicking with the left mouse button.  Then set Min and Max 
accordingly, e.g. ‘10000’ and ‘1000000’.  The precision of your entries should 
match that of the cursor readout, i.e. to three, six, or nine decimal places 
(see Section 8.5).  Note that you can also enter the fixed scale values in 
exponential form, which in the present example would be Min =1e4 and Max 
=1e6. 

To plot your results in the most meaningful way, you can select Linear or 
Logarithmic scaling. 

 

   Figure 7-4   Graph configuration: y-axes. 
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7.2.5 SETTING UP THE VIEW 

On the View window, you set up the general appearance of your graph.   

The Display options apply to all graphs.  With these, you can: 

• Display the grid, or not, 

• With the grid displayed, display the minor divisions, or not, 

• Display the cross-wire cursors, or not, 

• Display the legends (trace labels), or not. 

The Complex plane options are available only with Complex plane selected 
as the Plot Type.  These options allow you to: 

• Use isotropic scaling (equal scaling on x- and y-axes), or not, 

• Invert the y-axis, or not. 

 

   Figure 7-5   Graph configuration: view. 

An example of an historic graph appears in Figure 7.6.  Note the precision of 
the cursor reading, which appears at the bottom of the graph frame, in the 
centre.  On the Options window for Graphics, (see Section 8.5) you can 
select a precision of three, six, or nine (default setting) decimal places. 
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   Figure 7-6   Example of a Bode plot. 

Before attempting to use the cursor slider bar, (see Figure 7.6) locate the 
graph cursor by clicking onto the appropriate trace, then hold down the 
keyboard Ctrl key whilst moving the mouse pointer to the slider bar. 
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7.2.6 ZOOMING IN ON THE GRAPH DETAIL 

The cross-wire cursor allows you to zoom in on any part of a plot, on both 
axes.  Simply click and stretch a box over the required area.  When you 
release the left mouse button, the selected area appears as a full graph.  See 
Figure 7.7.  Click with the right mouse button to reveal a pop-up menu.  
This enables you to set up the graph configuration, zoom level and scroll 
time; to save the graph configuration or load a previously saved 
configuration; and to export, print or close the graph. 

 

   Figure 7-7   Example of graph zooming. 
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7.3 TABULATING YOUR RESULTS 

Selecting View Data on the Data File Information window displays your 
results in tabular form: 

 

If you do not select a particular unit and channel with Units/Channels 
used… then CellTest accesses all the data in the file. 

2. Data are stored in blocks of 1000 results.  To help you search through a 
large amount of data, you can go to the start of a data block specified by 
the Start at (×1000) slider bar.  Thus, you can start at result 0, 1000, 
2000, and so on.  As an additional aid, you can step through your selected 
block of 1000 results in smaller blocks, whose size you specify with the 
Block size slider bar.  Use the Next Block and Previous Block buttons for 
block selection. 

 

You can also display your results in an Excel table, which enables you to plot 
the results data in various ways.  Before you can do this, however, you must 
first convert the data file to CSV format.  See Section 7.4. 
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7.4 CONVERTING THE DATA FILE FORMAT 

Should you wish to export a data file to other applications, you must first 
convert it into an appropriate format.  CellTest converts the data files to 
.CSV format, which is suitable for the export of tabular data to Excel.  

The conversion procedure is: 

1. Click on the Convert button on the Data File 
Information window or on the Convert data files icon in 
the toolbar or, in the Tools menu, click on File 
Conversion…  This reveals the Data File Conversion 
window: 

 

2. Select the Data file to convert. 

3. Select the Target filename. 

6. Click on OK.  Your selected data file is now converted and stored under 
the target filename.  The converted file is displayed in Excel.  The graph 
facility in Excel allows you to display the data in many different formats. 
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7.5 NORMALISING THE MEASUREMENT DATA 

Normalisation is used primarily to cancel out errors in difficult 
measurement environments.  A typical application in which normalisation 
can be usefully applied is where dielectric tests are done on samples that are 
heated or cooled by a temperature controlled cryostat system.  The long 
wires with which the sample is connected are subject to many sources of 
stray impedance.  It is impractical to use the reference measurement mode, 
since this would require a second cryostat of exactly the same construction 
as the one containing the sample.  Here, measurement normalisation can be 
used to full advantage. 

Measurement normalisation corrects for the effect of stray impedances due 
to such things as the connection cables, sample holder, and temperature 
control system.  The measurements are made as quickly as possible, since 
only the sample is measured –not the reference capacitor, as is the case in 
the reference measurement mode.  

Normalisation is applied at all the measurement frequencies of interest.  A 
frequency sweep is made with the cryostat, sample holder and connecting 
leads set up as for the experiment, but without the sample inserted.  This 
means that the sample holder is measured as a capacitor with an air 
dielectric.  Each measurement result thus obtained comprises the impedance 
of the empty sample holder, plus any stray impedance in the measurement 
system. From the dimensions you enter as the Sample Definition, SMaRT 
calculates the impedance of the empty sample holder at each measurement 
frequency.  This gives a correction factor for each measurement frequency, 
which you save in an empty call data file for later use. 

Note that normalisation is most effective when the measured impedances 
are similar to the calculated values used in normalisation.  This can 
sometimes be arranged by varying the separation of the sample holder 
plates. 

The normalisation file for a particular experiment is created with a single 
sweep.  The sample may then be put into the sample holder, normalisation 
requested from the specified normalisation file, and measurements made at 
different temperatures. 

You can use measurement normalisation to advantage whenever you wish to 
capture data quickly and accurately.  Typical applications are in the 
measurement of fast changing systems, such as the cure of adhesives and 
thermo set polymers, etc.  
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7.5.1 NORMALISATION PROCEDURE 

The procedure for making a normalised measurement is: 

1. Mount the sample in the sample holder and connect the sample holder 
to the Sample inputs of the 1296. 

2. In the Experiment Editor, enter the experiment set-up, including the 
sweep and measurement parameters and the name of the Data file that 
is to hold the measured sample data. 

3. Save the experiment and close the Experiment Editor. 

4. Run the experiment, by clicking on the traffic light icon, choosing the 
experiment set up in Step 2, and selecting Start.  On the successful 
completion of this experiment, an icon representing the measured 
sample data file appears on the Project Viewer. 

5. Double-click on the sample data file icon to reveal the Data File 
Information window and use this to ascertain the sample capacitance. 

6. Remove the sample from the sample holder. 

7. Edit the experiment set up in Steps 2 and 3 to specify the Data file that 
is to hold the empty cell data. 

8. In the Experiment Editor, enter the Sample Definition –that is, the 
dimensions of the empty sample holder.  Specify the Sample Thickness 
to obtain an Empty Cell Capacitance that is approximately the same as 
the sample capacitance value obtained in Step 5. 

9. Save the experiment and close the Experiment Editor. 

10. Set the electrode gap of the sample holder to the same value as the 
sample thickness specified in Step 8. 

11. Re-run the experiment, by clicking on the traffic light icon, choosing the 
experiment edited in Steps 7 and 8, and selecting Start.  On the 
successful completion of this experiment, an icon representing the 
empty cell data file appears on the Project Viewer. 

12. From the Tools menu, select ‘Create a Normalised Data File’.  A 
Normalisation window appears. 

13. In the Normalisation window, enter the names of the measured sample 
data file and the measured empty cell data file.  A default name is 
presented for the file that is to hold the normalised data, but you can 
change this if you wish.  Then select OK to create normalised data file.  
The Data File Information window now appears, which enables you to 
select and display your normalised data.  
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8. Support Features 

8.1 USING THE SUPPORT FEATURES 

The SMaRT support features are available in the Tools menu. 

On the top level of this menu are the followings items: 

 

Some options are described elsewhere in the User Guide.  The Add/Remove 
Hardware option is in Section 4.1 and the Normalised Data File option is in 
Section 7.5.   

The Advanced Features are diagnostic tools.  These should be used only 
under the direction of a qualified engineer or service technician, should the 
need arise. 

Printer Set-up is a standard Windows function and its use is explained in 
the Microsoft help text. 

The remaining features are described in the present section, as shown above. 

 

Note that you can also access the options described in Sections 
8.2 through 8.5 by clicking on the Options icon in the toolbar. 
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8.2 SELECTING THE GENERAL OPTIONS 

Figure 8.1 shows the Cell Test General options (default settings).   

The use of each item in this window is self-explanatory, if you are familiar 
with the terms used in cell testing with the 1294 or 1296.  If you are not, 
then read Section 1 of the User Guide. 

Some options are selected from list of settings, others by ticking a box. 

To disable an option, click to remove the tick in the adjacent box.  
Alternatively, to reinstate the option, click to tick the box. 

 

   Figure 8-1   General options window. 
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8.3 SELECTING THE VIEW OPTIONS 

Figure 8.2 shows the View options window.  The significance of most settings 
is self-explanatory.  Examples of the various project tree styles are shown in 
Figure 8.3. 

 
   Figure 8-2   View option window. 

 

   Figure 8-3   Project tree styles. 
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8.4 SELECTING THE MESSAGES OPTIONS 

Figure 8.4 shows the message options (default settings).   

The use of each item in this window is self-explanatory, if you are familiar 
with the terms used in cell testing with the 1294 or 1296.  If you are new to 
these, then read Section 1 of the User Guide.  

To disable an option, click to remove the tick.  To reinstate, click to tick. 

 

   Figure 8-4   Messages options window. 
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8.5 SELECTING THE GRAPHICS OPTIONS 

Figure 8.6 shows the graphics options (default settings).  The use of each 
item in the window is mainly self-explanatory.   

The third option down means ‘Do you want to be asked whether you want to 
change the graph set-up, when the experiment starts?’ 

To disable an option, click to remove the tick.  To reinstate, click to tick. 

 

   Figure 8-5   Graphics option window. 

8.6 SEARCHING THE GPIB FOR LISTENERS 

Searching the GPIB for listeners allows you to check which instruments in 
your System are operational and available for use. 

To start a search, click on the  icon in the toolbar or select Tools → 
Search for GPIB Listeners.  At the end of the search, a list of available 
instruments is displayed. 
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